
Automating Photoshop
By Martin Evening

Once you have mastered the basics of Photoshop you can save 
yourself a lot of time by learning the various ways you can automate 
Photoshop to avoid repetitive tasks and speed up your workflow. 
One way you can do this is to familiarize yourself with the various 
keyboard shortcuts. There are a lot of these in Photoshop, so it is 
best to learn a few at a time, rather than try to absorb everything at 
once. Throughout this book I have indicated the Mac and PC key 
combinations for the various shortcuts in Photoshop. While I have 
probably covered nearly all those one might use on a regular basis, 
there are even more shortcuts available. Most of these are listed in the 
Shortcuts PDF, which is available from the book website. Or, you can 
go to the Keyboard Shortcuts dialog in the Photoshop Edit menu to 
see which are available.
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Working with Actions
You can record a great many operations in Photoshop using actions. 
Photoshop actions are application scripts that can record a sequence of 
events carried out in Photoshop and then be replayed on other images. 
Image processing routines that you carry out on a regular basis, when 
working in Photoshop, can be recorded as actions to save you the 
bother of having to laboriously repeat the same steps over and over 
again on subsequent images. Not only that, you can also use actions to 
batch process multiple images.
	 A new action must always be saved within an action set in the 
Actions panel. Such action sets can then be saved and shared with 
other Photoshop users so that they too can replay the same recorded 
sequence of Photoshop steps on their computers.

Playing an action
The Actions panel already contains a set of prerecorded actions called 
Default Actions.atn. If you go to the Actions panel fly-out menu you can 
load other sets from the menu list such as: ‘Frames’, or ‘Image Effects’ 
(Figure 1). To test these out, open an image, select an action from the 
menu and press the Play button. Photoshop then applies the recorded 
sequence of commands to the selected image. However, if the number of 
steps in a complex action exceeds the number of available histories there 
will be no way to completely undo all the commands once an action has 
completed. As a precaution, I suggest you either take a Snapshot via the 
History panel or save the document before executing an action. If you 
are not happy with the result of an action, you can always go back to the 
saved snapshot in History or revert to the last saved version.
	 The golden rule when replaying an action is to never do anything 
that might interrupt the progress of the action playback in Photoshop. 
If you launch an action in Photoshop you must leave the computer 
alone and let Photoshop do its thing. If you click on the finder while an 
action is in playback mode this may sometimes cause an action to fail.
	 Photoshop actions are always appended with the .atn file extension 
and, by default, saved to the Photoshop Actions folder inside the 
Photoshop Application Presets folder, but you can store them anywhere 
you like. If you want to install an action that you have downloaded 
or someone has sent to you, all you have to do is double-click it and 
Photoshop will automatically load the action into the Actions panel 
(and launch Photoshop in the process if the program is not already 
running at the time).
	 When you first install Photoshop you will find some actions are 
already loaded in the Default Actions Set and you can load more 

Figure 1 Here is the Actions panel 
showing the panel fly-out menu options. 
You can easily add more action sets to the 
Actions panel via this list.
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by going to the Actions panel fly-out menu and clicking on one of 
the action sets in the list (see Figure 1). There are also many more 
Photoshop actions available on the Internet. A useful starting point 
is the Adobe Add-ons site: creative.adobe.com/addons. This provides 
access to lots of extras for Photoshop, including Photoshop actions.

Recording actions
To record an action, you’ll first need to open a test image to work with 
and you must then create a brand new action set to contain the action 
(or select an existing set, other than the Default Actions set). Next, 
click on the Create new action button at the bottom of the Actions 
panel (Figure 2), which adds a new action to the action set. Give the 
action a name before pressing the Record button. At this stage you 
can also assign a custom keystroke using the Function keys (¡–fi)  
combined with the S and/or C (Mac), L (PC) keys. You will 
then be able to use the assigned key combination to initiate running 
a particular action. Now carry out the Photoshop steps you wish to 
record and when you have finished click the Stop recording button.
	 When recording a Photoshop action, I suggest you avoid recording 
commands that rely on the use of named layers or channels that may be 
present in your test file, as these will not be recognized when the action 
is applied to a new image. Also try to make sure that your actions 
are not always conditional on starting in a specific color mode, being 
of a certain size, or being a flattened image. If the action you intend 
recording is going to be quite complex, the best approach is to carefully 
plan in advance the sequence of Photoshop steps you intend to record. 
A Stop can always be inserted in an action, which will then open a 
message dialog at a certain point during playback (see page 7 and 
Figure 4). This can be used to include a memo to yourself (or another 
user replaying the action), reminding what needs to be done next at 
a certain stage in the action playback process. Or, if the action is to 
be used as a training aid, a Stop message could be used to include a 
teaching tip or comment.
	 As I mentioned already, if you want to save an action, it must be 
saved within an action set. So if you want to separate out an action 
and have it saved on its own, click on the Create new set button in the 
Actions panel to create a new set, drag the action to the set, name it and 
choose Save Actions… from the Actions panel fly-out menu (the action 
set must be highlighted, not the action). If you hold down the CO 
(Mac), LA (PC) keys as you choose Save Actions… this saves 
the text descriptions of the action steps for every Photoshop action 
currently in the Actions panel. The following steps show how to record 
a basic action.

A: This Action Set contains inactive actions. 
B: Indicates one or more action steps are 	
 inactive and contains a Pause. 
C: An active step. 
D: An active step with a Pause which will 	
 open a dialog box.
E: An active step with a Stop which will 
open a message dialog.
F: An inactive step.

Figure 2 The Actions panel column 
showing the different action state icons.
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2 I then clicked on the Create new action button (circled) in the Actions panel, named 
this action ‘300ppi-glossy-inkjet’ and clicked the ‘Record’ button.

3 I used a sample image to apply all the steps required to sharpen an image for press.

1 This show a practical example of how to create an action, by showing how print 
sharpening steps could be recorded as an action. The first step was to create a new action 
set. To do this, I clicked on the Create new set button (see Figure 2), named this ‘Print 
sharpening actions’ and clicked OK.
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4 When I had finished recording all the steps, I clicked the Stop button to end the 
recording. In the Actions panel view shown on the right you can see a fully expanded list 
of all the steps, including the settings used. This action could then be applied to other 
images by clicking on the Play button, or could be applied as a batch action process.

Troubleshooting actions
If an action doesn’t seem to be working, first check that the image to 
be processed is in the correct color mode. Many actions are written 
to operate in RGB color mode only, so if the starting image is in 
CMYK, the color adjustment commands won’t work properly. Quite 
often, assumptions may be made about the image data being flattened 
to a single layer. One way to prevent this from happening is to start 
each action by using the A. shortcut (to select the top-most 
visible layer), followed by the Merge Visible to new layer shortcut 
(COSe [Mac], LASe [PC]). These two steps will 
add a new, flattened merged copy layer at the top of the visible layer 
stack. Some pre-written actions require that the start image fits certain 
criteria. For example, the Photoshop-supplied ‘Text Effects’ actions 
require that you begin with an image that contains layered text and 
with a text layer selected.
	 If you have just recorded an action and are having trouble getting it 
to work, you can inspect it command by command. Open a test image, 
expand the action to display all the items, select the first step in the 
action, hold down the C (Mac), L (PC) key and click on the Play 
button. This allows you to play the action one step at a time. You need 
to have the C (Mac), L (PC) key held down and keep clicking the 
Play button to run through the remaining steps. If there is a problem 
with one of the action steps then double-click the relevant action step 
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in the list to rerecord it. You will then need to make sure that action 
step is selected, keep the C (Mac), L (PC) key held down again 
and click on the Play button to continue.

Actions panel in Button mode
Figure 3 shows the Actions panel in Button mode, where all you have 
to do is click on a button to initiate a recorded action. This makes 
replaying actions even simpler.

Limitations when recording actions
Most Photoshop operations can be recorded as an action, such as 
image adjustments, History panel steps, filters, and most Photoshop 
tool operations, although you should be aware that tools such as the 
Marquee and Gradient tool are recorded based on the current set ruler 
unit coordinates (see sidebar on recording ruler units). If you go to the 
Actions panel menu and check the ‘Allow Tool Recording’ item, this 
does allow things like brush strokes to be recorded as part of an action. 
However, it is important that the images you record the action on and 
play back the action on have the same pixel dimensions.

Actions only record changed settings
One of the problems you commonly face when preparing and recording 
an action is what to do if certain settings are already as you want them 
to be. Actions only record a setting if it actually changes something. For 
example, let’s say you record an image size adjustment where you want 
the image resolution to end up at 300 pixels per inch, but the image 
is already defined as being 300 pixels per inch. In these situations, 
Photoshop won’t record anything. To get around this you must 
deliberately make the image resolution something different before you 
record a ‘set image resolution’ step. Then, when you change the pixel 
resolution, this will get recorded. For example, while recording, you 
could go to the Image Size dialog and temporarily make the image, say, 
200 pixels per inch (without resampling the image), then record setting 
the resolution to 300 pixels per inch. When you are finished recording, 
delete the 200 pixels per inch step from the completed action.

Recording ruler units
For actions that involve recording the placement of objects or drawing 
of marquee selections, it is a good idea to record setting the ruler units 
as part of the action. If you go to the Photoshop preferences and choose 
‘Units & Rulers’, you can set the rulers to ‘Percentage’. By recording this 
as part of an action, any subsequent placement of Photoshop guides, 

Figure 3 The Actions panel in Button mode.
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placement of the type tool or use of the marquee tools can be recorded 
relative to the proportions of the document. When you then replay an 
action, the action should work effectively no matter what the size or 
proportions of the image.

Stops and Pauses
When editing an action, you can insert what is known as a Stop. This 
allows you to halt the action process to display an alert message. This 
could be a useful warning like the one shown in Figure 4, which could 
be displayed at a key point during the action playback. If you click in 
the Stop/Pause column space to the left of the action step, next to a 
step where a dialog can be shown, you can instruct Photoshop to open 
the dialog at this point (see the red icons in the Stop/Pause column in 
Figure 2). This allows you to custom edit the dialog box settings when 
playing back an action.

Background layers and bit depth
The lack of a Background layer can also stop some actions from 
playing. There is not always much you can do about this, other than to 
convert the current base layer to a Background layer by choosing Layer 
➯ New ➯ Background from Layer before playing the action. This isn’t 
always advisable since you wouldn’t want to accidentally flatten all the 
layers in an important image. Alternatively, you could make a flattened 
duplicate of the current image and then run the action. You may also 
want to check the bit depth of the image you are applying the action to. 
If the bit depth is 16-bit, not all Photoshop filters will work and you will 
need to convert the photo to 8-bits per channel mode first.

Layer naming
Action recordings should be as unambiguous as possible. For example, 
if you record a step in which a named layer is brought forward in the 
layer stack, in playback mode the action will look for a layer with 
exactly the same name. Therefore, when adding a layer include the 
naming of the layer as part of the action (but don’t use Layer 1, Layer 2, 
etc., as this may only cause confusion with Photoshop’s default layer 
naming). Also, use the main Layer menu or Layer key command 
shortcuts to reorder the layer positioning. Doing this will make your 
action more universally recognizable.

Volatile actions
One thing you have to be aware of is that although actions will remain 
stored in the Actions panel after you quit Photoshop, a newly installed 

Figure 4 The Record Stop dialog.
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Figure 5 The Insert Menu Item dialog will initially say None Selected. You can then 
select a menu item such as Window ➯ Arrange ➯ Tile All Vertically, and click OK. 
When the Action is replayed the inserted menu item will be included in the playback list.

or created action can easily become lost should you suffer a computer 
or program crash before you quit. Photoshop Actions can also become 
lost if you trash the Photoshop preferences or uninstall Photoshop. It is 
therefore always a good idea to take the precaution of saving any newly 
created or newly edited action sets so you don’t lose them. These can 
be saved anywhere you like, but they ideally need to be stored in the 
Username/ Library/Application Support/Adobe/Adobe Photoshop CC/
Presets/Actions folder (Mac), or Username\AppData\Roaming\Adobe\ 
Adobe Photoshop CC\Presets\Actions folder (PC), if they are to be seen 
listed at the bottom of the Actions panel fly-out menu (see Figure 1).

Inserting menu items
There are some things which can be added as part of a Photoshop 
action that can only be included by forcing the insertion of a menu 
item. For example, Photoshop doesn’t record zoom tool or View menu 
zoom instructions. However, if you select ‘Insert Menu Item’ from the 
Actions panel fly-out menu, as you record an action, you will see the 
dialog shown in Figure 5. The Menu Item dialog will initially say None 
Selected, but you can now choose, say, a zoom command from the 
View menu and the zoom instruction will be recorded as part of the 
action, although frustratingly the image won’t actually zoom in or out 
until you replay the action! I often use the Insert Menu Item as a way 
to record actions that open certain Photoshop dialogs that I regularly 
need to access, such as the various Automated plug-ins. This saves me 
having to navigate the Photoshop menus to access them.

Tutorial Builder
Over on the labs.adobe website is an interesting tool called Tutorial 
Builder: labs.adobe.com/downloads/tutorialbuilder.html. Currently at 
version 3, this allows you to record steps carried out in Photoshop and 
compile these as ready made, step-by-step Photoshop tutorials. Also 
included is the code required to replay each step using the Touch SDK 
to replay the steps in Photoshop via a mobile device.
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Batch processing actions
One of the great benefits of working with actions is the ability to 
batch process images. The Batch dialog can be accessed via the File ➯ 
Automate menu and can also be accessed via the Tools ➯ Photoshop 
menu in Bridge. You first need to select an action set and action from 
the Play section and then set the Source and Destination. Figure 6 shows 
an example of the Batch Action dialog set to apply a prerecorded action. 
The Source can be all currently open images, the selected images in the 
Bridge window, an Import source, or a specific folder, in which case, 
you’ll need to click on the Choose… button below and select a folder of 
images. The following items in the Source section will only show if the 
Folder or Bridge options are selected. These allow you to decide how to 
handle files that have to be opened first in Photoshop before applying 
an action. Most of the time you will want to leave the ‘Override Action 
“Open” Commands’ unchecked. If there is a recorded ‘Open’ item, such 
as an ACR processing step in an action, checking ‘Override Action 
“Open” Commands’ overrides popping the ACR dialog for each image 
and simply applies the ACR processing. However, if you check this and 
there is no open step recorded in the action, this will prevent the action 
from running. Only check the ‘Include All Subfolders’ option if you 
want to process all the subfolders within the selected folder. If you are 
processing a bunch of raw files and wish to override seeing the ACR 
dialog then do check the ‘Suppress File Open Options Dialogs’ option. 

Figure 6 An example of the Batch Action dialog set to apply a prerecorded action.
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Figure 7 The Batch interface naming and 
numbering options.

Lastly, if you want to prevent the Missing Profile and Profile Mismatch 
dialogs appearing when you batch process images, check the ‘Suppress 
Color Profile Warnings’ option. As a consequence of doing this, if there 
is a profile mismatch, Photoshop checks what you did previously. If you 
previously chose to keep the image in its own profile space, then this is 
how the images will be batch processed. If there is no profile present, 
Photoshop checks to see if your previous preference was set to: Ignore, 
Assign a profile, or Assign and convert to the working space, and acts 
accordingly. If ‘Stop For Errors’ is selected, this halts the batch processing 
in Photoshop any time an action trips up over a file for some reason. You 
can prevent this by selecting the ‘Log Errors to File’ option instead. This 
allows the batch processing to complete, but creates a log report of any 
files that failed to process.
	 In the Destination section you have three options. If you choose 
‘None’, Photoshop processes the selected files and leaves them open. If 
you choose ‘Save and Close’, Photoshop does just that and overwrites 
the originals, and if you choose ‘Folder’, you’ll need to click on the 
Choose… button to select a destination folder. 
	 Now it might so happen that the action you have selected to run 
the batch process with may contain a Save or Save As command that 
uses a specific file format and format settings, and this action step will 
contain a recorded Save destination. It might be the case that the Save 
destination is an important part of the action, but if the destination 
folder no longer exists, the action will fail to work (besides, you can 
specify a destination folder within the Batch dialog itself). So in the 
majority of instances, where the action contains a Save instruction, I 
recommend you check the ‘Override Action: “Save As” Commands’ 
checkbox. If the action does not contain a Save or Save As command, 
then leave this option unchecked.
	 If a folder is selected as the destination, you can use the file 
renaming fields below to apply a renaming scheme to the processed 
files. You can use any combination you like here, but if you select a 
custom file extension option this must always go at the end. A complete 
list of the file naming and numbering options are shown in Figure 7. 
These also let you define the precise numbering or renaming of the 
batch processed files. As you edit the fields, you will see an example of 
how the naming will be applied in the ‘Example:’ section (circled in 
Figure 6).
	 It is easy to customize the File Naming with your own fields. In 
Figure 6, I created a batch process where the images were renamed 
‘Bookimage_’ followed by a three digit serial number, followed by an 
underscore ‘_’ and with the date expressed as: year; month; and day. 
Note that the numbering was set to start at ‘112’. So in this example the 
file name structure would be as follows: Bookimage_112_140618. 



11Adobe Photoshop CC for Photographers: Automate

Figure 8 Photoshop Droplets (shown 
here with output folders).

Figure 9 The Create Droplet dialog.

Creating a droplet
Photoshop actions can also be converted into self-contained, batch 
processing applications, known as droplets, which can play a useful role 
in any production workflow. When you drag a document or a folder 
on top of a droplet icon this launches Photoshop (if the program is not 
already running) and initiates the action sequence contained within the 
droplet. The beauty of droplets is you only need to configure the batch 
processing settings once and they’ll then be locked into the droplet. 
Droplets can be stored anywhere you like, although it makes sense 
to have them readily accessible such as in an easy-to-locate system 
folder (see Figure 8). Droplets can perform Save and Close operations 
(overwriting the original), or can be configured to save the processed 
images to an accompanying folder as a new version of the master image.
	 To make a droplet, go to the File ➯ Automate menu and choose 
Create Droplet… Figure 9 shows the Create Droplet interface and you 
will notice that the Create Droplet options are identical to those found 
in the aforementioned Batch Actions dialog. Choose a location to save 
the droplet to and, if required, you can also choose a destination folder 
for the droplet processed files to be saved to. When you are done, 
click OK. You can name a droplet anything you like, but if a droplet 
is created on a Mac you’ll need to add a .exe extension for it to be PC 
compatible. If you are a Mac user and someone sends you a droplet that 
was created using a PC, it can be made Mac compatible by dragging it 
on top of the Photoshop application icon first to convert it.
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Figure 10 This shows the Image 
Processor (formerly known as Dr. Russell 
Brown’s Image Processor). This Scripting 
dialog can be configured to process single 
or multiple images, apply Photoshop 
actions, add copyright info and save the 
files to a designated folder location in 
one or more of the following file formats: 
JPEG, PSD or TIFF. The destination folder 
will contain the processed images and 
these will be separated into folders named 
according to the file formats selected. Once 
configured, you can click on the Save… 
button to save these settings and load them 
again at a future date.

Image Processor
The Image Processor (Figure 10) is located in the File ➯ Scripts menu 
in Photoshop and can also be accessed via the Tools ➯ Photoshop 
menu in Bridge. The Image Processor is a fine example of what Scripts 
can do when they are presented via an easy-to-use interface. The Image 
Processor basically allows you to select a folder of images (or select all 
open images) to process and select a location to save the processed files 
to. The Image Processor can then be configured to run a Photoshop 
action (if required) and save the processed files using either the JPEG, 
PSD or TIFF file formats. However, it also allows you to simultaneously 
process and save files in multiple file formats. This can be very handy 
if you wish to produce, say, both a TIFF version at high resolution 
and a JPEG version ready to place in a web page layout. For example, 
when you are preparing images that are destined to be shared by 
email or published via the Web, the Image Processor is a handy tool 
to use because you can not only resize the images as part of the image 
processing, but you can instruct the Image Processor to convert the 
image from its current profile space to sRGB, which is the ideal RGB 
space for general purpose Web viewing.

Image Processor Pro

An advanced version of Image Processor 

can be downloaded via the following link: 

tinyurl.com/j6kdauy. This includes extra 

features and functionality.
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Exporting and importing presets
When you initially installed Photoshop, you may have noticed a dialog 
asking ‘Would you like to migrate presets from the following versions?’ 
In that dialog the most recent previous version of Photoshop appeared 
listed. This allowed you to automatically import the preset settings 
that were contained in your old version of Photoshop. If you ignored 
this dialog and clicked ‘No’, you can go to the Edit menu in Photoshop 
and choose Presets ➯ Export/Import Presets… This opens the dialog 
shown below in Figure 11. In Import Presets mode, select the Presets 
folder from your old version of Photoshop and click on an arrow to 
add selected presets to the list on the right (or click ‘Add All’), then 
click ‘Import Presets’. In Export Presets mode, select presets from the 
list on the left and click on an arrow to add these to the list on the right 
(or click ‘Add All’), then click ‘Export Presets’. This will allow you to 
create an ‘Exported Presets’ folder that contains a subset of presets 
folders, mirroring what was in the original Presets folder.

Figure 11 This shows the Export/Import Presets dialog.

Migrating presets

If you install Photoshop CC as a new 

program the preset migration migrates 

settings from both the user library Presets 

folder as well as the Photoshop application 

Presets folder. It also migrates all active 

presets as well as any non-loaded presets 

that are around.
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Figure 14 The Fit Image dialog.

Figure 13 An example of the Export 
Layers to Files… script dialog.

Figure 12 The Photoshop Scripts menu.

Scripting
For most of us, the prospect of writing scripts is quite scary and I freely 
confess I am one of those who has looked at the scripting manuals and 
simply shuddered at the prospect of having to learn computer code. 
Steps have been taken though to make scripting more accessible to 
the general user. You can start by referring to the Photoshop Scripting 
Guide and other PDF documents about scripting that can all be 
found at: adobe.com/devnet/photoshop/scripting.html. You can also 
download pre-made scripts from the Adobe Add-ons website: creative.
adobe.com/addons.
	 To start with, go to the Scripts menu in the Photoshop File menu 
(Figure 12). There you will see a few sample Scripts that are readily 
available to experiment with. Among these is a script called ‘Export 
Layers to Files’ (Figure 13). This can be used to generate separate file 
documents from a multi-layered image. Other scripts I like to use 
include the Load Files into Stack…, which I find useful when preparing 
images for stacks image processing or before choosing Edit ➯ Auto-
Align layers. 

Automated plug-ins
A number of automated plug-ins are available via the File ➯ Automate 
menu. These enable Photoshop to perform a complex set of procedures 
based on simple user input. Adobe has also made Automated plug-ins 
‘open source’, which means it is possible for third-party developers to 
build their own Automated plug-ins for Photoshop.

Fit Image
Fit Image… (Figure 14) is a very simple Automated plug-in, which 
allows you to automate image resizing. To launch, choose File ➯ 

Automate ➯ Fit Image… It is well suited for the preparation of images 
for screen-based design work. You can enter the pixel dimensions you 
want the image to fit to, by specifying the maximum pixel width or 
height. Note that if you enter the same pixel dimensions for the width 
and height, Fit Image can be used to simultaneously batch process 
landscape and portrait format images. Scripts can be made to call other 
scripts, so it is often useful to include Fit Image within a more complex 
script, or as part of a recorded action sequence.
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